
CZEラピッドチャージバリアント分析
キット

PA 800 Plus医薬品分析システム用
オペレータガイド

2021年2月RUO-IDV-05-8656-JA-D



本書はSCIEX機器をご購入され、実際に使用されるお客様にむけてのものです。本書の著作権は保護
されています。本書および本書の一部分を複製することは、SCIEXが書面で合意した場合を除いて固
く禁止されています。

本書に記載されているソフトウェアは、使用許諾契約書に基づいて提供されています。使用許諾契約

書で特に許可されている場合を除き、いかなる媒体でもソフトウェアを複製、変更、または配布する

ことは法律で禁止されています。さらに、使用許諾契約書では、ソフトウェアを逆アセンブル、リ

バースエンジニアリング、または逆コンパイルすることをいかなる目的でも禁止することがありま

す。正当とする根拠は文書中に規定されているとおりです。

本書の一部は、他の製造業者および/またはその製品を参照することがあります。これらには、その名
称を商標として登録しているおよび/またはそれぞれの所有者の商標として機能している部分を含む場
合があります。そのような使用は、機器への組み込みのためSCIEXにより供給された製造業者の製品
を指定することのみを目的としており、その権利および/またはライセンスの使用を含む、または第三
者に対しこれらの製造業者名および/または製品名の商標利用を許可するものではありません。

SCIEXの保証は販売またはライセンス供与の時点で提供される明示的保証に限定されており、また
SCIEXの唯一かつ独占的な表明、保証および義務とされています。SCIEXは、明示的・黙示的を問わ
ず、制定法若しくは別の法律、または取引の過程または商慣習から生じるかどうかに関わらず、特定

の目的のための市場性または適合性の保証を含むがこれらに限定されない、他のいかなる種類の保証

も行いません。これらのすべては明示的に放棄されており、購買者による使用またはそれから生じる

不測の事態に起因する間接的・派生的損害を含め、一切の責任または偶発債務を負わないものとしま

す。

研究専用。診断手順には使用しないでください。

ここに記載されている商標および /または登録商標は、関連するロゴを含め、米国および /またはそ
の他の特定の国における AB Sciex Pte. Ltd.、またはその該当する所有者の所有物です。

AB SCIEX™ はライセンスの下で使用されています。
© 2021 DH Tech. Dev. Pte. Ltd.

AB Sciex Pte. Ltd.
Blk33, #04-06 Marsiling Industrial Estate Road 3
Woodlands Central Industrial Estate, Singapore 739256

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用

RUO-IDV-05-8656-JA-D2 / 34



CZE Rapid Charge Variant
Analysisキット..................................................................................................................................5
安全性................................................................................................................................................5
使用目的.............................................................................................................................................5
必要な機器と材料..............................................................................................................................5
保管条件........................................................................................................................................6
顧客が用意する機器および材料....................................................................................................6
必要な検出器................................................................................................................................7
必要なカートリッジまたはキャピラリー.....................................................................................7

メソッドとシーケンス.......................................................................................................................7
サンプルの準備..................................................................................................................................8

IgGテストサンプルを準備する.....................................................................................................8
タンパク質テスト混合サンプルを準備する.................................................................................8
タンパク質サンプルの準備...........................................................................................................8
タンパク質サンプルの緩衝液交換を実施する..............................................................................9

PA 800 Plus システムを準備する .....................................................................................................9
UV検出器 の取り付け.................................................................................................................10
インターフェースブロックをクリーニングする........................................................................10
カートリッジを取り付ける.........................................................................................................10
緩衝液トレイをロードする.........................................................................................................10
サンプルトレイをロードする.....................................................................................................12

サンプルを実行する.........................................................................................................................14
サンプルプロジェクトを作成する..............................................................................................14
シーケンスを作成して実行を開始する.......................................................................................15

廃棄物処理.......................................................................................................................................19
カートリッジを保管する..................................................................................................................19
カートリッジを保管する............................................................................................................19
保管後のカートリッジを準備する..............................................................................................20

データの分析....................................................................................................................................20
NIST IgGサンプルのデータを分析する......................................................................................20
タンパク質テスト混合サンプルのデータを分析する.................................................................21

トラブルシューティング..................................................................................................................22
キャピラリーをクリーニング.....................................................................................................25

A 有害物質情報.....................................................................................................................................27

B メソッド............................................................................................................................................28
キャピラリーコンディショニングメソッド.....................................................................................28
分離メソッド....................................................................................................................................29
シャットダウンメソッド..................................................................................................................31

CZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用

オペレータガイド

3 / 34RUO-IDV-05-8656-JA-D

目次



お問い合わせ先.....................................................................................................................................33
お客様のトレーニング.....................................................................................................................33
オンライン学習センター..................................................................................................................33
消耗品を購入する............................................................................................................................33
SCIEXサポート................................................................................................................................33
サイバーセキュリティ.....................................................................................................................33
ドキュメント....................................................................................................................................34

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用

RUO-IDV-05-8656-JA-D4 / 34

目次



SCIEX CZE Rapid Charge Variant Analysisキットは、PA 800 Plus Pharmaceutical Analysis
Systemを使用して、モビリティに基づいてタンパク質のチャージバリアントを分析するため
に必要な試薬を提供します。このメソッドは、チャージバリアントを定量化するために使用

できる高速で単純な分離です。ベアフューズドシリカキャピラリーの分離マトリックスと動

的コーティングの両方として機能する緩衝液を使用します。

このドキュメントでは、CZE Rapid Charge Variant Analysisキットを使用したサンプル調製
について説明します。また、PA800Plusソフトウェアソフトウェアを使用したデータ収集お
よびデータ分析の手順も提供します。

注：システムを安全に使用する手順については、『システム概要ガイド』を参照してくだ

さい。

安全性

原料と試薬の適切な取り扱いに関する情報については、sciex.com/tech-regulatoryで入手可
能な安全データシート (SDS)を参照してください。標準的なラボの安全ガイドラインに常に
従ってください。有害物質情報については、有害物質情報を参照してください。

使用目的

CZE Rapid Charge Variant Analysisは、検査室専用です。

必要な機器と材料

注： 再注文部品番号の付いたアイテムの場合、再注文数量はキット数量と異なる場合があ

ります。
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表 1 CZE Rapid Charge Variant Analysisキット(部品番号 C44790)

部品番号の

再注文

数量コンポーネント

C44790125 mL酸洗浄/再生液 (0.1 M HCl)

該当なし140 mLCZE Rapid Charge Variant Separation buffer

C48034140 mLCE-Grade Water

4774363 mgタンパク質テスト混合

表 2 SCIEXの追加材料

部品番号数量コンポーネント

144709100PCRマイクロバイアル (200 µL)

A62250100ユニバーサルバイアルキャップ、ブルー

A62251100ユニバーサルバイアル

表 3追加の必要な試薬または材料

部品番号ベンダー説明

8671NIST米国国立標準技術研究所（NIST）ヒト化IgG1Kモノクロー
ナル抗体

UFC801024ミリポア（オプション）Ultracel-10メンブレンを備えたAmicon
Ultra-4遠心フィルターユニット

保管条件

• 受領後、CZE Rapid Charge Variant Analysisキットを2°C〜8°Cで保管します。

• 受領後、NIST IgGサンプルを–35°C〜–15°Cで保管します。NIST IgGサンプルを初めて解
凍した後、必要な量を取り除き、残りを–35°C〜–15°Cの分割量で保管します。

顧客が用意する機器および材料

• パウダーフリー加工の手袋 (ネオプレンまたはニトリル製のものを推奨)

• 安全メガネ
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• 実験用白衣

• マイクロ遠心分離機または同等品、および微小遠心分離管

• ボルテックスミキサー

• ピペットと適切なヒント。

• 分析バランス

必要な検出器

214 nmフィルター付きのUV検出器が必要です。

必要なカートリッジまたはキャピラリー

次のいずれか:

• 組み立て済みカートリッジ (部品番号 A55625)

• キャピラリーカートリッジ（部品番号 144738）およびキャピラリー、ベアフューズドシ
リカ、内径50 µm（部品番号 338451）

メソッドとシーケンス

sciex.comからメソッドとシーケンスをダウンロードします。メソッドとシーケンス
は、32 KaratTMソフトウェアを使用して手動で作成することもできます。メソッドを参照し
てください。

メソッドをPA 800 Plusコントローラー：C:\32Karat\projects\CZE\Methodに保存します。

シーケンスを C:\32Karat\projects\CZE\Sequenceに保存します。

公開時点では、SCIEXのウェブサイトでシーケンスと次のメソッドを利用できます。

• CZE Analysis.seq:シーケンス。

• CZE Rapid Charge Variant Analysis.met:サンプルの分離を実行します。

• CZE Capillary Conditioning.met:毎日の開始時にキャピラリーを調整します。

• CZE Shutdown.met:シーケンスの最後にキャピラリーをクリーニングし、UVランプを
オフにします。

CZEラピッドチャージバリアント分析キットPA800Plus
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サンプルの準備

IgGテストサンプルを準備する

1. IgGテストサンプルを準備する。

• 最初の実行では、NIST IgGサンプルを含むバイアルを室温で解凍し、10 µLずつ溶
液を分取します。

分割量を1つ予約し、残りの分割量を–35°C〜–15°Cで最大5年間保管します。

• その後の実行では、10 µLの分割量の1つを室温で解凍します。

2. ストック溶液の入ったバイアルに90 µLのCEグレード水を加えます。

最終濃度は1 mg / mLです。

3. バイアルを最大速度で10秒間ボルテックスして混合します。

4. マイクロ遠心分離機で、バイアルを最大速度で5秒間遠心分離して、サンプルをバイア
ルの底に移動させます。

5. 95 µLをマイクロバイアルに慎重に移します。

バイアルの底に気泡がないことを確認してください。気泡が存在する場合は、手順 4
を繰り返します。

タンパク質テスト混合サンプルを準備する

タンパク質テスト混合はトラブルシューティングに使用できます。テスト混合で数回実行す

るか、通常のサンプルと同じ実行のコントロールとして含めます。タンパク質テスト混合の

結果が正しい場合、分離は機能しており、他のサンプルに問題があります。

1. タンパク質テスト混合を含むバイアルに2mLのCE-グレード水を加え、1分間ボルテッ
クスして混合します。

溶液には、各分析試料に対してリゾチーム、シトクロムC、リボヌクレアーゼAが0.5
mg/mL含まれます。

2. 凍結と解凍の繰り返しを制限するには、溶液の一部を0.5 mLマイクロバイアルに分取
します。実験計画に適したボリュームを選択してください。

使用していないときは、–35°C〜–15°Cで最大2年間保管します。

注：タンパク質テスト混合は、CZE分離緩衝液の性能を確認するために使用されま
す。これは分子の性能を示すものではありません。

タンパク質サンプルの準備

IgGテストサンプルと同様に、1 mg/mLの最終タンパク質濃度が推奨されます。

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
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1. サンプルをバイアルに加え、CE-Grade Waterで希釈します。

最終濃度は1 mg / mLです。

2. バイアルを最大速度で10秒間ボルテックスして十分に混合します。

3. マイクロ遠心分離機で、バイアルを最大速度で5秒間遠心分離して、サンプルをバイア
ルの底に移動させます。

注： CZE分離緩衝液は、pIが7以上の分子用に設計されています。

エレクトロフェログラムにピークが表示されない場合は、サンプルを最終濃度0.5
mg/mLに希釈してから、サンプルを再度実行します。

タンパク質サンプルの緩衝液交換を実施する

この分析のシグナル強度と分解能は、サンプルの塩濃度に敏感に反応します。塩分濃度が高

すぎる場合、信号レベルが低くなるか、ピークテーリングが発生します。次の手順で

Microcon-10 kDa遠心分離フィルターユニットとの緩衝液交換を行います。

1. 1mLのサンプルをMicrocon-10 kDa遠心フィルターユニットに追加します。

2. 4,000 gで 15分間遠心分離します。

3. 2 mLの20 mMトリス、pH 7.8をフィルターユニットに加え、4,000gで25分間遠心分
離します。

4. ステップ 3を2回繰り返します。

5. Microcon-10 kDa遠心フィルターユニットをバイアルに取り付け、1,000gで3分間遠心
分離します。

サンプル溶液がバイアルに回収されます。

6. 収集したタンパク質溶液を適切な滅菌チューブに移します。

7. SDS-MW Sample Bufferを最後の1 mLの容量に加えます。

タンパク質サンプルの最終濃度は1 mg/mLでなければなりません。

PA 800 Plusシステムを準備する
本項では、データを取得するためにPA 800 Plusシステムを準備する手順について説明しま
す。

本項で説明する手順は、システムがすでに適切にインストールされ、初期化されていること

を前提としています。
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UV検出器の取り付け

1. PA 800 Plusシステムの電源を切り、UV検出器を取り付けます。システムメンテナン
スガイドを参照してください。

2. システムの電源を入れ、ランプが暖まるまで少なくとも 30分間待ちます。

インターフェースブロックをクリーニングする

注意：システムに損傷を与える恐れ。緩衝液が電極、オープニングレバー、キャピラリー

の端、インターフェースブロックに結晶化しないようにしてください。塩の結晶は、キャ

ピラリーの破損、電極の曲がり、バイアルの詰まり、注入の失敗につながる可能性があり

ます。

使用後または化学薬品の交換時に、電極、オープニングレバー、キャピラリー端、およびイ

ンターフェースブロックをクリーニングしてください。詳細な手順については、『システム

メンテナンスガイド』を参照してください。

定期的かつ徹底的な洗浄を行わないと、分離緩衝液が蒸発してシステム内に塩が堆積する可

能性があります。

カートリッジを取り付ける

1. カートリッジを箱から取り出し、必要に応じてキャピラリーを取り付けます。

2. カートリッジをPA 800 Plusシステムに取り付けます。

緩衝液トレイをロードする

注意：システムに損傷を与える恐れ。1.8 mLを超える液体をバイアルに入れないでくださ
い。また、廃液バイアルには 1.8 mLを超えて溜まらないようにしてください。バイアルの
容量が1.8 mL以上が含まれている場合、圧力システムに損傷を与える恐れがあります。

1. 実行するサンプルの数に応じて、適切な数のバイアルを満たし、キャップします。図

1を参照してください。8つのサンプルの各設定について、次を準備します。

• 5つのユニバーサルバイアル、それぞれ1.5mLCZERapid Charge Variant Separation
bufferが含まれます

• 2つの汎用バイアル、1.5 mL CE-グレード水が含まれます

• 1つの汎用バイアル、1.5 mL Acidic Wash solutionが含まれます

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
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• 2つの汎用バイアル、アウトレットバッファトレイの廃棄物の位置向けとして、
1 mL CEグレード水が含まれます

図 1ユニバーサルバイアルとキャップのセットアップ

説明項目

ユニバーサルバイアルキャップ1

最大充填ライン2

ユニバーサルバイアル3

2. 次の図に示すように、バイアルをバッファトレイに入れます。図 2を参照してくださ
い。各行は少なくとも8回の実行に十分です。

注：このアプリケーションでは、すべてのバイアルとキャップは最大 8回分析を行
えるように設計されています。乾燥ゲルやその他の化学物質で汚染されている可能

性があるため、キャップは再利用しないでください。
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図 2 16回実行のバッファトレイレイアウト

• CSB：CZE分離バッファ

• 水：CE-グレード水

• HCL：1.5 mL酸洗浄液

• 廃棄物：CEグレード水1 mL

注：電気泳動中に、緩衝液のイオン強度が変化します。分離メソッドでは、イオン

の消耗を防ぐために、8回の実施後に緩衝液バイアルを増やすようにプログラムされ
ています。

サンプルトレイをロードする

1. サンプルを準備します。各サンプルは次のとおりです。

a. 必要に応じて、サンプルを室温で5〜10分間解凍します。

b. 少なくとも50 µLのサンプルをマイクロバイアルに移します。

c. サンプルが含まれるマイクロバイアルをユニバーサルバイアルに入れます。

d. ユニバーサルバイアルに青いキャップを取り付けます。
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図 3サンプルバイアルのセットアップ

説明項目

ユニバーサルバイアルキャップ1

マイクロバイアル2

ユニバーサルバイアル3

ユニバーサルバイアル内のマイクロバイアル4

2. 図 4に示すように、サンプルトレイにユニバーサルバイアルを入れます。
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図 4サンプルトレイレイアウト

サンプルを実行する

サンプルプロジェクトを作成する

この手順では、32KaratTMソフトウェアの管理権限を持つユーザーのユーザー名とパスワードが
必要です。

1. デスクトップの32 KaratTMソフトウェアのアイコンをダブルクリックします。

2. Tools >Enterprise Loginをクリックし、ユーザー名とパスワードを入力して、Login
をクリックします。

3. Tools > System Administration Wizardをクリックします。

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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図 5管理ウィザードのウィンドウを選択する

4. Projectをクリックし、Next.をクリックします。

5. ウィザードの指示に従って、CZEプロジェクトを作成します。

詳細については、32 KaratTMソフトウェアヘルプまたはシステム管理ガイドを参照し
てください。

6. 必要に応じて、SCIEXウェブサイトからメソッドおよびシーケンスファイルを
ダウンロードします。メソッドとシーケンスを参照してください。

7. メソッドをプロジェクトのメソッドフォルダーにコピーします。デフォルトでは、こ

れは C:\32Karat\projects\CZE\Methodです。

8. シーケンスをプロジェクトのシーケンスフォルダーにコピーします。デフォルトでは、

これは C:\32Karat\projects\CZE\Sequenceです。

シーケンスを作成して実行を開始する

1. デスクトップのPA800Plusソフトウェアアイコンをダブルクリックして、PA800Plus
ソフトウェアを開きます。

2. PA 800 plusウィンドウで、ウィンドウの右上の （Run）をクリックします。

CZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用

オペレータガイド
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3. CZE機器をクリックし、CZEAnalysisをクリックします。システム管理が有効になっ
ている場合、プロンプトが表示されたらユーザー名とパスワードを入力します。

Instrument Status and Direct Controlページが開きます。

図 6 Instrument Status and Direct Control ページ

4. （Describe）をクリックします。

5. Applicationリストの CZEをクリックします。Sequenceリストで、Browseを
クリックした後、CZE Analysisシーケンスを参照します。プロンプトが表示された
ら、ユーザー名とパスワードを入力します。

ページが更新され、選択したシーケンスが表示され、シーケンス内のすべての行がサ

ンプルとして指定されます。

6. シーケンスの最初と最後の行のタイプを設定します。最初の行はキャピラリー

コンディショニング用で、最後の行はシステムのシャットダウン用です。

a. 最初の行（CZE Conditioningメソッド）をクリックして選択し、Rows領域の
（Always）をクリックします。

b. 最後の行（CZEShutdownメソッド）をクリックして選択し、Rows領域の
（Always）をクリックします。

シーケンスの最初と最後の行の Type列のアイコンは三角形になりました。

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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図 7Describe sequence rows and columns コンディショニングメソッドが「常に」
に設定されたページ

7. （オプション）システム適合性サンプルを含む行の場合、行をクリックして選択し、

（Control）をクリックします。

8. ウィンドウの右下の （Save）をクリックし、 （Finish完了）をクリッ
クします。

9. Numberof samplesフィールドで矢印ボタンをクリックして、実行のサンプル数を設
定します。

サンプル数が変わると、右側のバッファとサンプルトレイの画像が更新され、正しい

数のバイアルと実行の位置が表示されます。たとえば、図 2では、8つのサンプルに
対して1行の試薬が必要です。16サンプルには2行の試薬が必要です。

CZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用

オペレータガイド
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図 8 CZE分離のトレイマップ

10. バッファおよびサンプルトレイがロードされていない場合、 （Load）を
クリックし、PA 800 Plusシステムにバッファおよびサンプルトレイをロードしてか
ら、ドアを閉じます。

11. （Next）をクリックし、Yes - run nowをクリックします。

図 9ロードされたサンプルのプロンプト

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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図 10データ収集時のPA 800ソフトウェア

廃棄物処理

警告！生物学的危険、有害化学物質の危険性。化学物質のバイアルおよび

キャップ、および調製済みサンプルの残りを処分する際は、必要に応じて、

地域の指令に従います。これらには、規制化合物や生物学的危険性のある物

質が含まれていることがあります。

カートリッジを保管する

カートリッジを保管する

1. シャットダウンメソッドを実行して、キャピラリーをクリーニングします。

2. 50 psiで5分間、0.1M HClでキャピラリーを洗浄します。

キャピラリーは0.1M HClで満たされます。

3. システムからカートリッジを取り外します。

4. キャピラリーの端をCE-グレード水CE-Grade Water

CZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用

オペレータガイド
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保管後のカートリッジを準備する

• カートリッジが 1日以上使用されていないか、長期間保管されていた場合は、CZEコ
ンディショニングメソッドを使用してキャピラリーをコンディショニングします。

データの分析

NIST IgGサンプルのデータを分析する

1. 32 KaratTMソフトウェアで、実行からシーケンスを開きます。

2. 最初の実行用にデータファイルを開きます。

3. File > Open > Methodをクリック、CZE Rapid Charge Variant Data Analysisを選
択、次に OKをクリックします。

4. 統合イベントを調整し、テストサンプルのすべてのピークを正しく統合します。メソッ

ド開発ガイドの「Integration（統合）」の章を参照してください。

図 11 NIST IgGサンプルのエレクトロフェログラムの例

5. File>Saveをクリックしてメソッドを保存し、サンプルを含むシーケンス内の行に適
用します。

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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タンパク質テスト混合サンプルのデータを分析する

1. 32 KaratTMソフトウェアで、実行からシーケンスを開きます。

2. 最初の実行用にデータファイルを開きます。

3. File > Open > Methodをクリック、CZE Rapid Charge Variant Data Analysisを選
択、次に OKをクリックします。

4. 統合イベントを調整し、テストサンプルのすべてのピークを正しく統合します。

メソッド開発ガイドの「Integration（統合）」の章を参照してください。

図 12タンパク質テスト混合サンプルのエレクトロフェログラムの例

5. File>Saveをクリックしてメソッドを保存し、タンパク質テスト混合サンプルを含む
シーケンス内の行に適用します。

CZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用

オペレータガイド
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トラブルシューティング

修正アクション考えられる原因症状

1. タンパク質はこの分離技術には適合しま
せん。

2. サンプルをさらに1.0mg/mLの濃度に希釈
して、サンプルの負荷を減らします。

3. 緩衝液の交換を実施して、サンプルから
塩分を除去します。タンパク質サンプル

の緩衝液交換を実施するを参照してくだ

さい。

4. キャピラリーの端を拡大して検査します。
断面がギザギザになっている場合は、端

を再度カットするか、キャピラリーを交

換します。

5. キャピラリーをクリーニングします。キャ
ピラリーをクリーニングを参照してくだ

さい。

6. 次を実行します。

a. 分離メソッドでは、バイアルの増分間
隔を8回未満の実行に減らします。こ
れにより、分離緩衝液バイアルがより

頻繁に変更されます。

b. シャットダウンメソッドでは、最後の
キャピラリー水リンスステップ

を0.1 M HClまたは10 mMリン酸など
の酸性溶液によるリンスに置き換えま

す。次に使用する前にキャピラリーに

酸性溶液を充填することができます。

キャピラリーの両端をCE-GradeWater
に保管します。

7. キャピラリーを交換します。

注：塩基性溶液はキャピラリー壁をマ

イナスイオン化し、タンパク質との相互

作用を引き起こすため、キャピラリーの

洗浄には使用しないでください。

1. タンパク質のpIは7未
満です。

2. サンプル濃度が高す
ぎます。

3. サンプルの塩濃度が
高すぎます。

4. キャピラリー端の切
断が均等ではありま

せん。

5. キャピラリーチップ
の端が汚れている

か、詰まっていま

す。

6. タンパク質はキャピ
ラリー壁に吸着され

ています。

7. キャピラリー
は、0.1 N NaOHな
どの塩基性溶液で洗

浄しました。

ピークのブロード

化、分解能の低下

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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修正アクション考えられる原因症状

1. サンプル濃度が0.5 mg/mLから1.0 mg/mL
の間であることを確認します。必要に応

じて、サンプルを水で希釈し、サンプル

を再度実行します。

2. バイアルとキャップを交換するか、メソッ
ドを変更します。

• 清潔なバイアルに新たに準備した試薬
を満たした後、バイアルを清潔な

キャップでカバーし、トレイのバイア

ルを交換します。

• Checkバイアル廃液バイアルに1.0 mL
の水が含まれており、アウトレット緩

衝液トレイにあることを確認します。

• サンプル注入手順の後に、タイムプロ
グラムに1つ以上の水浸漬手順を追加
します。

1. サンプル濃度が高す
ぎます。

2. バイアルまたは
キャップが汚染され

ています。

キャリーオーバー

緩衝液トレイ内のバイアルに正しい試薬が

入っており、正しい場所にあることを確認し

てください。緩衝液トレイをロードするを参

照してください。

緩衝液トレイが正しく

セットアップされていま

せん。

高電流

1. キャピラリーをクリーニングします。キャ
ピラリーをクリーニングを参照してくだ

さい。

2. サンプルバイアルに少なくとも 50 µLの
サンプルがあることを確認してください。

3. 緩衝液の交換を実施して、サンプルから
塩分を除去します。タンパク質サンプル

の緩衝液交換を実施するを参照してくだ

さい。

1. キャピラリーチップ
の端が汚れている

か、詰まっていま

す。

2. サンプル量が少なす
ぎます。

3. サンプルの塩濃度が
高すぎます。

低シグナル

CZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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修正アクション考えられる原因症状

最終サンプル濃度が少なくとも0.5 mg/mLで
あることを確認してください。すべての分析

試料に適用するサンプルサンプル濃度が著し

く低い場合は、10 kDa分子量カットオフ
（MWCO）のスピンフィルターを使用してサ
ンプルを濃縮します。

または、分離メソッドでサンプル注入の時間

を増やします。

サンプル濃度が低すぎま

す。

低強度ピーク

1. ソフトウェアで分離メソッドを開き、キャ
ピラリー温度が正しいことを確認します。

2. キャピラリーをクリーニングします。キャ
ピラリーをクリーニングを参照してくだ

さい。

3. キャピラリーウィンドウとチップを検査
します。どちらかが壊れている場合は、

カートリッジを交換します。

4. 清潔なバイアルに新たに準備した試薬を
満たした後、バイアルを清潔なキャップ

でカバーし、トレイのバイアルを交換し

ます。

1. キャピラリーの温度
が正しくありませ

ん。

2. キャピラリーチップ
の端が汚れている

か、詰まっていま

す。

3. キャピラリーウィン
ドウまたは端が破損

しています。

4. 試薬が汚染されてい
ます。

低電流

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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修正アクション考えられる原因症状

1. 32KaratTMソフトウェアで分離メソッドを
開き、次のことを確認します。

• 正しい電圧です。

• Normal極性チェックボックスが選択
されています。

実行中、PA 800 Plusシステムのオレンジ
色のLEDを観察します。通常の極性の電
圧が印加されると点灯します。

2. サンプルがサンプルトレイの正しい場所
にあることを確認します。サンプルトレ

イをロードするを参照してください。

3. サンプルチューブを遠心して、底に気泡
がないことを確認します。

4. キャピラリーウィンドウとチップを検査
します。どちらかが壊れている場合は、

カートリッジを交換します。

5. 分離電流を検査します。安定していれば、
サンプルはキャピラリーの壁に吸着して

いることになります。キャピラリーを交

換します。

1. 分離メソッドに誤り
があります。

2. サンプルがサンプル
トレイの正しい位置

にありません。

3. サンプルバイアルの
底に気泡がありま

す。

4. キャピラリーウィン
ドウまたは端が破損

しています。

5. サンプルはキャピラ
リー壁と相互作用し

ました。

ピークなし

キャピラリーをクリーニングします。キャピ

ラリーをクリーニングを参照してください。

キャピラリーチップの端

が汚れているか、詰まっ

ています。

同時低電流の有無に

かかわらず、移行時

間を短縮

緩衝液を10秒～20秒超音波処理して、気泡を
除去します。

分離緩衝液に気泡があり

ます。

不安定な電流により

移行が遅くなる

キャピラリーをクリーニング

以下の手順を使用して、詰まっていたり汚れているキャピラリーをクリーニングします。

1. CE-Grade Waterにより75 psiで2分間すすぎます。

2. 酸洗浄液（0.1 M HCl）により75 psiで2分間すすぎます。

3. CE-Grade Waterにより75 psiで2分間すすぎます。

4. それでもキャピラリーに問題がある場合は、キャピラリーのアウトレット端から1mm
を切り取ってから、CE-Grade Waterで75 psiで5分間すすぎます。

CZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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それでも問題が解決しない場合は、キャピラリーを交換してください。

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
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次の情報に注意して、関連する安全対策を講じる必要があります。詳細については、それぞ

れの安全性データシートを参照してください。これらは要求に応じて入手できるか、弊社の

ウェブサイト（sciex.com/tech-regulatory）からダウンロードできます。

HCS 2012による危険物分類。

酸洗浄/再生液 (0.1 M HCl)

危険！重度のやけどおよび目の損傷を引き起こします。

CZEラピッドチャージバリアント分離緩衝液

警告！軽度の皮膚炎を引き起こします。アレルギー性皮膚刺激を引き起こす可能性

があります。水生生物に有害です。

タンパク質テスト混合

危険！吸入するとアレルギー、喘息の症状、呼吸困難を引き起こすことがありま

す。

その他の試薬

これらのコンポーネントは有害物質として分類されていません。

• CE-Grade Water

他のベンダーの試薬については、使用前にベンダーの安全性データシートをお読みください。

CZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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CZE Rapid Charge Variant Analysisアプリケーションには、3つの方法が必要です。

キャピラリーコンディショニングメソッド

注： Initial Conditionsタブと UV Detector Initial Conditionsタブの値は、すべてのメソッド
で同じになります。

図 B-1初期条件タブ

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
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図 B-2 UV検出器初期条件タブ

図 B-3キャピラリーコンディショニングメソッド時間プログラムタブ

分離メソッド

注： Initial Conditionsタブと UV Detector Initial Conditionsタブの値は、すべてのメソッド
で同じになります。

CZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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図 B-4初期条件タブ

図 B-5 UV検出器初期条件タブ
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図 B-6分離メソッド時間プログラムタブ

シャットダウンメソッド

注： Initial Conditionsタブと UV Detector Initial Conditionsタブの値は、すべてのメソッド
で同じになります。

図 B-7初期条件タブ

CZEラピッドチャージバリアント分析キットPA800Plus
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図 B-8 UV検出器初期条件タブ

図 B-9シャットダウンメソッド時間プログラムタブ
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お客様のトレーニング

• 北米：NA.CustomerTraining@sciex.com

• ヨーロッパ：Europe.CustomerTraining@sciex.com

• ヨーロッパおよび北米以外：sciex.com/education

オンライン学習センター

• SCIEX University™

消耗品を購入する

SCIEX消耗品の再注文はオンライン（store.sciex.com）をご利用ください。ご注文の場合は
見積書、注文確認書、または発送書類に記載されているアカウント番号をお使いください。

現在、SCIEXオンラインストアは米国、英国、ドイツのみに対応しておりますが、将来的に
他の国にも拡大予定です。米国、英国、ドイツ以外のお客様は、地域のSCIEXサービス担当
者までご連絡ください。

SCIEXサポート
SCIEXおよびその代理店は、十分に訓練を受けた保守／技術専門要員を世界中に有していま
す。システムまたは起こり得る技術的問題に関するご質問にお答えします。詳細な情報につ

いては、SCIEXウェブサイト (sciex.com)を参照するか、以下の連絡先までお問い合わせく
ださい。

• sciex.com/contact-us

• sciex.com/request-support

サイバーセキュリティ

SCIEX製品のサイバーセキュリティに関する最新のガイダンスについては、
sciex.com/productsecurityを参照してください。

CZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用
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お問い合わせ先

mailto:NA.CustomerTraining@sciex.com
mailto:Europe.CustomerTraining@sciex.com
https://sciex.com/education
https://training.sciex.com
https://store.sciex.com
https://sciex.com
https://sciex.com/contact-us
https://sciex.com/request-support
https://sciex.com/productsecurity


ドキュメント

このバージョンのドキュメントは、以前のすべてのバージョンのドキュメントに優先します。

このドキュメントを電子的に閲覧するにはAdobe Acrobat Readerが必要です。最新バージョ
ンをダウンロードするには、https://get.adobe.com/readerにアクセスします。

ソフトウェア製品のドキュメントについては、ソフトウェアに付属のリリースノートまたは

ソフトウェアインストールガイドを参照してください。

ハードウェア製品のドキュメントを検索するには、システムまたはコンポーネントに付属の

カスタマーリファレンス DVDを参照してください。

ドキュメントの最新版はSCIEXのwebサイト（sciex.com/customer-documents）で入手でき
ます。

注：このドキュメントの無料の印刷版を請求するには、sciex.com/contact-usまでお問い合
わせください。

オペレータガイドCZEラピッドチャージバリアント分析キットPA800Plus
医薬品分析システム用

RUO-IDV-05-8656-JA-D34 / 34

お問い合わせ先

https://get.adobe.com/reader
https://sciex.com/customer-documents
https://sciex.com/contact-us

	オペレータガイド
	目次
	CZE Rapid Charge Variant Analysisキット
	安全性
	使用目的
	必要な機器と材料
	保管条件
	顧客が用意する機器および材料
	必要な検出器
	必要なカートリッジまたはキャピラリー

	メソッドとシーケンス
	サンプルの準備
	IgGテストサンプルを準備する
	タンパク質テスト混合サンプルを準備する
	タンパク質サンプルの準備
	タンパク質サンプルの緩衝液交換を実施する

	PA 800 Plus システムを準備する
	UV検出器 の取り付け
	インターフェースブロックをクリーニングする
	カートリッジを取り付ける
	緩衝液トレイをロードする
	サンプルトレイをロードする

	サンプルを実行する
	サンプルプロジェクトを作成する
	シーケンスを作成して実行を開始する

	廃棄物処理
	カートリッジを保管する
	カートリッジを保管する
	保管後のカートリッジを準備する

	データの分析
	NIST IgGサンプルのデータを分析する
	タンパク質テスト混合サンプルのデータを分析する

	トラブルシューティング
	キャピラリーをクリーニング


	有害物質情報
	メソッド
	キャピラリーコンディショニングメソッド
	分離メソッド
	シャットダウンメソッド

	お問い合わせ先
	お客様のトレーニング
	オンライン学習センター
	消耗品を購入する
	SCIEXサポート
	サイバーセキュリティ
	ドキュメント



